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Getting Started

About This Document

This Quick Reference Guide is intended to provide you with basic
information that will enable you to take advantage of ICVERIFY’s
features and begin processing transactions right away. If you have not
completed setup yet, refer to your Quick Setup Guide for information
on how to set up ICVERIFY to process transactions.

Conventions Used in This Manual

Different processing networks use different labels for similar
functions. In other words, a function may have a different name
depending on the processing network used. The ICVERIFY Graphical
User Interface (GUI) will use the terminology native to your
processing network, but this manual must occasionally present
information using a hybrid of these mixed terms. For example, the
command “Settle/Close Batch” might be known as  Settle, Settle
Batch, Close, or Close Batch, depending on the processing network.
An attempt will be made to display all of the common terminology for
a particular function so that it may be readily recognized.

Tips for New Users

If you have never processed credit card, debit card or check guarantee
transactions before, you may be wondering how to begin. This section
is intended to provide you with some ideas to help get you up and
running as quickly as possible. You may want to start out by reading
the sections titled Overview of Processing Networks (starts on page 5)
and Processing Credit Card Transactions (starts on page 9).

To get acquainted with ICVERIFY, try running it in Training Mode.
When Training Mode is used, ICVERIFY will simulate a response
from the processing network without actually dialing out and
processing transactions. All transactions authorized or settled while in
Training Mode are stored separately from live transactions. While in
Training Mode, the software will always approve transactions done for
an even amount. Transactions done for an odd amount are usually
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rejected. Training Mode is a no-risk tool that can be used to learn how
ICVERIFY operates without having to worry about the consequences
of making mistakes while practicing. To place ICVERIFY in Training
Mode, select Options from the Edit pull-down menu, then click the
Training Mode check box.

When using Training Mode, there are some test card numbers
embedded in the software that can be used for testing purposes.
Pressing Ctrl-Alt-X simultaneously will fill in the appropriate fields
with credit card information. Processors recognize these cards as test
numbers and will not transfer any funds when transactions are done
with them. These cards will be declined by most processors when used
with a live merchant account, but even if they do not generate an
approval they can still be used to test your modem’s ability to connect
with the processing network (or to practice in Training Mode).

ICVERIFY has a context-sensitive help feature that can be used while
processing transactions. At the bottom of the graphical user interface
there is a large field that normally contains a list of transactions.
Clicking on the tab with the question mark will activate the context-
sensitive help. The field that normally lists transactions will then
provide you with information about menu items as the cursor is moved
over them.

In addition to the context-sensitive help, there are some online help
files available:

• A help file for the Graphical User Interface. This can be accessed
by pressing F1 when ICVERIFY is running.

 
• A help file for multi-user and multi-merchant integration. This

file can be accessed by pressing F1 when ICVMLT32.EXE is
loaded (ICVMLT32.EXE is an integral part of a multiple user
setup).

 
• A help file for the setup program. This can be accessed by

pressing F1 in Advanced Setup.
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About ICVERIFY

ICVERIFY is the leading electronic transaction processing software
package on the market, providing credit card authorization /draft
capture, check guarantee and debit/ATM card authorization functions.
ICVERIFY operates on open-platform, Point-Of-Sale/business systems
worldwide. In addition to transaction processing, ICVERIFY provides
transaction storage, tracking and retrieval, reporting and integration
capabilities.

ICVERIFY is available for Windows, DOS or UNIX systems and can
be configured for single-user, multi-user and/or multi-merchant
operation (additional licensing may be required).

ICVERIFY solutions are used in both traditional retail environments
such as general retail, restaurant, hotel, car rental, travel, and in non-
traditional retail environments such as internet, kiosk, catalogue,
mail/phone order, CDPD and wireless communications. ICVERIFY
supports transaction processing through more than 100 major
processing networks.

ICVERIFY places many powerful features at your fingertips. With
ICVERIFY you can:

• Process VISA, MasterCard, American Express, NOVUS, Diners
Club, Carte Blanche, JCB and private label cards.

• Integrate easily with existing merchant software systems.Produce
comprehensive transaction reports which can be printed or viewed
on screen.  Transaction data can be imported/exported  into other
applications such as order entry programs, point-of-sale systems,
databases, Internet shopping carts, spreadsheets, etc.

• Store up to nine years of transaction information for financial
tracking, reconciliation and marketing demographics.

• Use 2-track Magnetic Stripe Readers for credit cards, 3-track
Magnetic Stripe Readers for credit cards and magnetic stripe
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driver’s licenses, keyboard MICR Readers for checks and
Magnetic Stripe Readers with pinpads for Debit/ATM cards.

New for Version 2.X

Some new features have been added to version 2.X of our Windows
product:

• A new, easier to use Graphical User Interface (GUI) that
dynamically changes to reflect the terminology and transaction
options of the merchant’s processing network.

 
• Improved import/export functionality. ICVERIFY can easily

import or export transaction data to and from external
applications.

 
• Installment (recurring billing) support.

• All printer configuration options have been removed from the
setup program. Report and receipt printers can be set up by
selecting Printer Setup from the File pull-down menu.

• Improved access to historical data. ICVERIFY is able to store up
to nine year’s worth of transaction data, which can be accessed
using a variety of reporting options. Version 2.0 allows the
merchant to reprint receipts from historical transactions.
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Overview of Processing Networks

As mentioned in the Quick Setup Guide, merchants are set up by their
financial institution to process their transactions through a Processing
Network. ICVERIFY uses your computer’s modem to contact this
processing network directly. The processor acts as an intermediary
between the merchant and the credit card company - it checks the
customer’s account and then (if the funds are available) approves the
transaction and routes the proceeds to the merchant’s account. In
addition to processing credit cards, many processing networks also
handle debit card and check guarantee transactions.

Not All Processors Handle Transactions the Same Way

Credit card processing always involves at least two steps (the second
step may or may not be apparent to the merchant):

The first step is generally referred to as Authorization. When a credit
card transaction for a sale is processed, ICVERIFY connects with a
credit card processing network and submits the transaction request.
The processing network takes the request and matches it with a
database maintained by the bank that issued the credit card. If there’s
enough credit available, the transaction will be approved and the
necessary funds will be held in reserve. This reduces the card’s “open
to buy”, reducing the available credit by the transaction amount. No
money changes hands at this point. Approved transactions are stored
by ICVERIFY in an open batch.  

The next step is the Settlement (or "Close Batch") procedure. A
merchant must settle before the funds from approved transactions will
be deposited in the merchant’s bank account. The authorization
process is uniform, but the settlement procedure is not. For
settlement, processors can be divided into two categories: Terminal
and Host.

Terminal-based processors require that the merchant connect to the
network and submit the open batch (which contains all of the
transactions that were previously approved) for settlement before the
funds from the approved transactions are deposited into the
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merchant’s account. This is done with one phone call; ICVERIFY
submits the open batch for settlement, gets an approval for the batch,
logs off and transfers the settled transactions from the open batch to
the history files. The money (minus any interchange fees) then gets
transferred to the merchant’s account. Settlement can be done at any
time with terminal-based processors.

A Host-based processor maintains the open batch. As ICVERIFY is
authorizing transactions, the host based processor keeps track of the
unsettled transactions for which the merchant has received approval.
Some host-based processors will auto-settle the merchant’s batch.
This means that at a certain point each day, the processor will
automatically close out the batch at its end. ICVERIFY uses the
computer’s internal clock to automatically transfer the open batch
into the history file without contacting the processor. Some host-
based processors do require that a settlement be performed, however
only batch totals are sent unless an out of balance condition is
encountered.

Most merchants that need to settle go through a settlement procedure
at the end of each day. ICVERIFY automatically processes all credit
cards authorized since the last settled batch. Once settlement has been
completed (either by the merchant or the processor) the funds will be
deposited the merchant’s account at a time determined by the
merchant’s agreement with the bank or card company. To settle an
open batch, choose Settlement/End Day from the Function pull-down
menu.

Here’s a summary of what has been covered so far:

• When processing transactions, merchants connect to a processing
network. This is an entity which acts as an intermediary between
the merchant and the credit card company.

• After authorizing transactions, it is necessary to settle them before
the funds from the approved transactions are transferred to the
merchant’s account.

 
• Most processors require that you dial into their network to

perform a settlement. Some host-based processors (not all) will
auto-settle transactions for you.
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What this means to you is that you may need to settle your transactions
before any funds get deposited into your account. The merchant help
desk at your financial institution will be able to provide you with
information about this - contact them if you have any doubt about
whether or not you need to settle transactions.
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ICVERIFY Screen Orientation

Tool Bar
Contains shortcut buttons to the
three transaction forms and other
commonly  used features

Menu Bar
With pull-down menus for
all functions.

Transaction Tabs
Allows fast access to each transaction type.
Terminology used for transactions is dependent on
merchant’s processing network

Tabs
One tab is used to display the
transactions in the transaction list box.
The tab with the question mark activates
the context-sensitive help feature.

Transaction List Box
Displays a list of transactions
that are stored in the current batch.

Status Box
Shows the merchant name, the operational
mode of the software and the status of the
transaction that is currently being
processed.
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Processing Credit Card Transactions

This section provides an overview of different features that are
commonly used when processing credit card transactions.

Training Mode
When set to training mode, ICVERIFY will simulate a response from
the processing network without actually dialing out and processing
transactions. Any transactions authorized or settled while in training
mode are stored separately from live transactions. While in  training
mode, the software will always approve transactions done for an even
amount. Transactions done for an odd amount are usually rejected.
Training Mode can be toggled on and off by selecting Options from
the Edit pull-down menu, then checking/unchecking the Training
Mode check box.

Real Time and Off-Line Group Processing
ICVERIFY defaults to processing transactions as soon as they are
entered (Real Time mode) but can also be configured to store them in
a batch for processing at a later time (Off-Line Group Mode). Both
methods are described below.

• If set to Real Time mode, ICVERIFY will immediately submit
transactions to the merchant’s processing network as soon as they
are entered.  Each time that a transaction is entered and the
submit button is pressed, ICVERIFY immediately uses the
computer’s modem to submit the transaction to the processing
network.

• If set to Off-Line Group Mode, ICVERIFY will store transactions
in an Off-Line group file for later processing. At some later point,
all of the transactions stored in this file can be submitted to the
processor by selecting Transmit Off-Line Group from the
Function pull-down menu, or by clicking on the Off-Line Group
Mode button. Off-Line Group Mode is more convenient for
some merchants because it cuts down on transaction processing
time (the modem connects to the processing network once and
submits all of the stored transactions as a group without re-dialing
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for each one). Also, the Off-Line Group can be transmitted to the
processor at a time that is convenient to the merchant.

ICVERIFY can be placed in Off-Line Group Mode by selecting Off-
Line Group Mode from the Function pull-down menu, or by clicking
the Off-Line Group Mode button (which has a picture of a telephone
on it).

As mentioned earlier, merchants normally need to perform a
settlement/end of day procedure before the funds from approved
transactions are deposited in the merchant’s account. This is done by
selecting Settlement/End Day from the Function pull-down menu.

The remainder of this section discusses the various transaction types
that can be performed using the retail or mail order market formats.
When loaded, ICVERIFY will display the terminology used by your
processing network. For example, the tab for a “credit” transaction
might be labeled as a “refund” or “return” depending on the
processing network that is being used.  For each transaction type
explained in the following pages, the manual will attempt to present
all of the terms normally used so that you can recognize the
transaction or process being discussed.

Note: When manually entering account numbers for credit card
transactions, it is not necessary to use dashes when entering the
number into the account number field.

Processing Credit Cards (Retail Format)

Sale
A sale is the most commonly used transaction in a retail format. It is
employed to charge a purchase to a customer’s credit account. It places
a “hold” on the customer’s open-to-buy (or available credit) by the
amount of the sale. Once a sale has been approved, the hold on the
customer’s credit will be valid for a limited time (three to thirty days
depending on the cardholder’s bank) before expiring and releasing the
hold on the funds in the customer’s credit account. Funds from an
approved sale transaction will not be deposited into the merchant’s
account until they have been settled. This will occur automatically if
the merchant is using a host-based processor that auto-settles
transactions. Merchants who are using a terminal-based processor (or
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a host-based processor that does not auto-settle) must perform a
Settlement/End Day procedure in order for the funds from sales to be
transferred to their merchant account. To perform a sale:

1. Swipe or manually enter the card information (the Customer
Name field will only be filled out for swiped transactions).

2. Enter information into Clerk and Comment if desired (these
fields are optional). The clerk’s name can be typed directly into
the field or selected from the drop-down list (Clerks can be added
to this drop-down list by selecting Options from the Edit pull-
down menu, then clicking on the Clerks tab). The Comment field
can be used to enter a comment or invoice number that can be
used to reference the transaction at some later point.

 
3. When all of the information has been entered, click on the Submit

button to process the transaction. ICVERIFY will then use the
computer’s modem to submit the transaction to the processing
network (unless the software has been placed in Training and/or
Off-Line Group Mode).

Void
This transaction is used to remove a sale from the open batch before it
has been settled. It does not cause any funds to be transferred. If a sale
has not been settled, it can be voided. If a sale has been settled, a credit
transaction must be performed (see below). To void a transaction:

1. Click on the Void tab. This pops up the Find Transaction box
with the search criteria already entered. Click on the Start Search
button to view a list of  transactions in the open batch that can be
voided.

 
2. Use your mouse to highlight the transaction that you wish to void.
 
3. Click on the Convert To button, then Void. This will fill in the

Void tab on the Credit Card Form with the information for that
transaction. Click on the Submit button.  For terminal-based
processors, ICVERIFY does not dial out for approval when a void
transaction is submitted (for most host-based processors, the
software will dial out to the processing network when the
transaction is submitted).



12

Note: Transactions that have been voided will continue to hold funds
from a customer’s open to buy until they have expired.

Credit/Refund/Return
A credit transfers money from the merchant’s account back to the
customer. It is used to return funds to the customer’s account after a
transaction has been settled. A void does not work in this type of
situation because it is designed to nullify an unsettled transaction (that
is, a transaction that is still in the open batch waiting for settlement).
For terminal-based processors, ICVERIFY does not dial out when a
credit is submitted. Instead, the credit is stored in the open batch and
transmitted at settlement. For most host-based processing networks,
the software will dial out when a credit is submitted.

Credit Void/Cancel Return/Refund Void
Similar to a void transaction, a credit void is designed to remove an
unsettled credit transaction from the open batch. A credit void cannot
be performed if the credit has already been settled. To void a credit
transaction:

1. Click on the appropriate tab (the terminology will vary by
processing network). This pops up the Find Transaction box with
the search criteria already entered. Click on the Start Search
button for list of all credit transactions in the open batch that can
be voided.

 
2. Select the credit transaction that you wish to void.
 
3. Click on the Convert To button, then Void. This will fill in the

Credit Void tab on the Credit Card Form with the information for
that transaction. Click on the Submit button. If a terminal-based
processor is being used, ICVERIFY will not dial out to the
processing network when the credit void is submitted. For most
host-based networks, the software will dial out when a credit void
is submitted.

 
Auth Only/Pre-Authorization
An auth only transaction is used to verify funds and return an approval
code. This transaction can not be settled unless it is completed by
using a force transaction (see below).
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Note: Auth Only transactions are cleared out of the batch each time
that a settlement is performed.

Force/Post-Authorization
A force transaction is primarily used to enter a voice approval into the
open batch. For example, a merchant submits a card for approval, gets
a “voice authorization” message and calls their merchant help desk for
a voice authorization. The merchant help desk gives the merchant an
approval code for the transaction over the phone. The merchant can
then enter the transaction into the open batch using a force transaction
and the approval code provided by the merchant help desk. A force
can also be used to complete an auth only transaction (see above).
To complete an auth only transaction with a force transaction:

1. Click on the appropriate tab (the terminology will vary by
processing network). This brings up the Find Transaction box
with the search criteria already entered. Click on the Start Search
button to view a list of all auth only transactions in the open batch
that can be forced.

 
2. Select the transaction that you wish to force.
 
3. Click on the Convert To button, then Force. This will fill in the

Force tab on the Credit Card Form with the information for that
transaction. Click on the Submit button. For merchants using a
terminal-based processing network, ICVERIFY will not dial out
when a force transaction is submitted (it will be transmitted at
settlement). For most host-based processing networks, the
software will dial out to the processing network when a force
transaction is submitted.

Processing Credit Cards (Mail Order Format)

The Mail Order format includes all of the transactions that are
available when using the retail format, plus two additional transaction
types (book and ship), which are often used in place of a sale
transaction.
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Since mail/telephone order transactions are generally not swiped (the
cardholder is not present), address verification information (the
customer’s address and ZIP code) is usually required to get the best
rate from the processing network. If the ZIP and address field are not
showing up on the credit card form, you will need to load the
Advanced Setup program, select the Merchant Information tab and
set the Address Verify?(Y/N) field to Y.  Please note that there may
be processor-specific setup items that affect the ability to pass address
verification information. For example, the FDMS - Cardnet processing
network requires an M. or W. terminal type in order to process
transactions with address verification information included. Other
processing networks may have different requirements. These setup
items are assigned by the processing network, and cannot be arbitrarily
changed.

Book
Booking a transaction authorizes and places a hold on the transaction
amount (similar to an auth only transaction). A book transaction is the
first part of a two-part transaction; it cannot be settled until it is
completed by a ship transaction (see below).

Ship
This transaction is used to complete a book transaction. Once a book
has been shipped, it is eligible for settlement. To ship a transaction:

1. Click on the Ship tab or button (the Ship button has a picture of a
package on it). This will pop up the Find Transaction box with
the search criteria already entered. Click on the Start Search
button to view a list of approved book transactions.

 
2. Find the book transaction that you wish to ship.
 
3. Click on the Convert To button, then select Ship. This will fill in

 the Ship tab on the Credit Card Form with the information for
 that transaction.

 
4. Adjust the transaction amount up or down as needed, then click

on the Submit button to ship the transaction. For terminal-based
processors, ICVERIFY will not dial out when a ship transaction is
submitted.
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Processing Debit Card Transactions
Processing debit cards is similar in many ways to credit card
transactions, but there are fewer transaction types. A debit card
transaction requires a card reader and an encrypted pinpad. ATM
pinpads must be programmed by the bank before they can be used by
ICVERIFY. Your pinpad must be Verifone 101 or Verifone 201
compatible.

Like credit cards, authorized debit card transaction must be settled
before the funds will be transferred to your merchant account. The
following transaction types are generally available:

Sale
This transaction transfers funds from an ATM/Debit account to a
merchant account. Use it for all ATM/Debit purchases.

Credit/Return/Refund
A return transaction transfers funds from a merchant account to an
ATM/Debit account. Use this transaction to reverse a sale transaction
that has been settled.

Void
A void transaction removes an unsettled sale transaction from the open
batch. Use it to remove a debit transaction prior to settlement.
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Setting Up a Pinpad

Debit card transactions require a pinpad. To set up your pinpad in
ICVERIFY, select the Edit pull-down menu, then Options, then
Serial Device. Click on the Configure Serial Device check box, then
enter the type of device and the port that it will be using.

ICVERIFY for Windows relies on proper system-level setup of the
com port in order to communicate properly with the pinpad. This is to
say that the com port specified using the menu option shown above
must also be properly configured via the Windows control panel. For
virtually all pinpads, the proper values are 1200 baud, 7 data bits, even
parity, one stop bit, and no flow control. All these parameters must be
set correctly or you may experience errors ranging from "The serial
device did not respond to initialization" errors to card swipes freezing
the GUI up.

Here is the procedure for Windows 95:

1. From the Start menu, select Settings, then Control Panel.
 
2. Double-click the System icon.
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3. Select the Device Manager tab.
 
4. Expand the Ports (COM &LPT) item by clicking the plus symbol

(+) to the left of it.
 
5. Double click the com port which is being used by the pinpad.
 
6. Select the Port Settings tab. Ensure the settings are:

• Bits per second: 1200
• Data bits: 7
• Parity: Even
• Stop bits: 1
• Flow control: none

7. Click on the OK button to save the settings and close the
Communications Port Properties dialog.

 
8. Click on the OK button to close the System Properties control

panel dialog.

The procedure is very similar for Windows 3.x:

1. From the Program Manager, double click Control Panels.
 
2. Double-click the Ports control.
 
3. Double-click the com port that is being used by the pinpad.
 
4. Ensure the settings are:

• Baud rate: 1200
• Data bits: 7
• Parity: Even
• Stop bits: 1
• Flow control: none

5. Click on the OK button to save the settings and close the settings
dialog.

 
6. Click on the Close button to close the Ports control panel dialog.
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Processing Check Guarantee Transactions

A check guarantee transaction can be performed with either a Driver's
license number, as shown above or by MICR verification as shown on
the following pages. the driver's license can be read using a 3-track
magnetic stripe reader attached to the system or entered manually. The
information printed at the bottom of the check can be read by a
Magnetic Ink Check Reader (MICR) attached to the system or entered
manually (only keyboard check readers are supported).

Driver's License Verification
This function, to approve a check that you have been presented, is
designed to protect you from possible fraud. Use this function to
ensure that the customer’s name does not appear on a list of people
who have written bad checks.

If your system includes a 3-track magnetic stripe reader, and the
customer has a magnetic stripe driver's license, the license may be
swiped to fill in this information.

Note that this function does not guarantee available funds. A sample
screen is displayed below (screen layout and terminology varies by
processing network).
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Magnetic Ink Check Reader Verification
This is a hardware option for reading account information encoded at
the bottom of the check. A sample screen is shown below (screen
layout and terminology varies by processing network)

The following fields are used when guaranteeing a transaction using a
keyboard MICR check reader:

Account #
This is the MICR number on the check. The reader will collect this
data from the check automatically.

ABA #
This is the ABA (bank) number on the check. The reader will collect
this data from the check automatically.

State
This is the State that the customer lives in. It may be read from a
magnetic stripe driver's license if a 3-track card reader is present.
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Finding and Editing Transactions

ICVERIFY provides a fast and simple way to view or edit credit card
transactions. The find transaction feature has been integrated with
transaction types where finding transactions comes into play. For
example, sales can be voided, so when the Void tab is clicked the Find
Current Transaction dialog will pop up and allow you to search for
all transactions that can be voided. The Credit Void, Force or Ship
tabs will behave the same way.

You can also find a transaction by clicking on the Find Transaction
button in the tool bar (Ctrl-F). This will display the Find Current
Transaction window shown below. To search through all transactions,
click on the Start Search button (Alt+S). A list of all transactions
using the search criteria that you have selected will then be displayed:

Note: This feature only searches for unsettled transactions. To locate
a settled transaction, use the Find Settled Transaction menu option
from the Utilities menu (See page 75 for more details).
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You can narrow your search by using the following criteria:

• Matching Data: (clerk, comment, account number, transaction
amount, or customer name).

 
• Transaction type: (all, sale, void, credit, credit void,

authorization only, book, ship, or force).

• Credit card type: (VISA, MasterCard, American Express,
Novus, DBO, or others).

 
• Status: (approved, declined, deleted or voided)
 
1. Once you have selected any desired search criteria, click the Start

 Search button (Alt+S). A list of the transactions meeting the
search criteria will be displayed.

 
 Note: To display one transaction at a time, select the One by One
radio button. Click on the Next Transaction button (Alt+X) to
move to the next transaction in the file.

 
2. Select the transaction by clicking on it in the Status field (or use

the arrows to scroll). You can reprint the receipt (Alt+R), or view
the transaction (Alt+T).  You can also convert the transaction to
another transaction by clicking on the Convert to button. The
transaction will appear on the screen, where it can be changed or
submitted as a new transaction (the original transaction will
remain in the file). Click “Clear Criteria” (Alt+C) or “New
Search” (Alt+N) if you need to start over.

Important Note: The Find Current Transaction feature is dependent
on the operational mode of the software. If ICVERIFY is operating in
Real Time Mode, the Find feature will search the current open batch.
When the software is operating in Off-Line Group Mode, you will only
be able to use the Find Current Transaction feature to find Off-Line
Group transactions (see page 22 for more details about Off-Line
Group Mode). If you are operating in Training Mode, the Find feature
will only find those Real Time Mode or Off-Line Group Mode
transactions done while in Training Mode (see page 66 for more
details about Training Mode).
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Off-Line Group Mode

Off-Line Group Mode is used to store transactions for batch
processing. When operating in Off-Line Group Mode, ICVERIFY will
not dial out to the processing network when a transaction is submitted.
Instead, each transaction is stored in an Off-Line Group Input file for
future processing. These stored transactions can then be transmitted at
some later point by selecting Transmit Off-Line Group from the
Function pull-down menu.

If an immediate response from the processor is not necessary, Off-Line
Group Mode is a very useful way of handling credit card transactions.
It cuts down on transaction entry time because the operator does not
need to wait for the software to dial out before entering the next
transaction. It also cuts down on transaction processing time because
the entire batch of Off-Line Group transactions can be submitted to the
processing network with one phone call.

It is possible to use an application such as a database or a spreadsheet
to create a file containing transaction data. This file can be imported
into ICVERIFY by using the Import Transactions feature (see page 42
for more details).

When you enter a transaction in Off-Line Group Mode and then press
the Submit button, you will get this message:

                OK: TRANSACTION ADDED TO BATCH

This means that the transaction has been stored in the Off-Line Group
File for future processing. When you are ready to submit the batch of
Off-Line Group transactions to the processing network, select
Transmit Off-Line Group from the Function pull-down menu and
ICVERIFY will use the computer’s modem to submit the Off-Line
Group transactions to the processing network.
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Finding Transactions While Using Off-Line Group Mode

ICVERIFY’s Find Transactions feature is dependent on the
operational mode of the software. If ICVERIFY is operating in Real
Time Mode, the Find feature will search the transactions stored in the
current open batch. When the software is operating in Off-Line Group
Mode, you will only be able to use the Find Transactions feature to
locate Off-Line Group transactions. These are transactions that have
been “keyed in” while in Off-Line Group mode but have not yet been
submitted to the processing network for approval. Keep the following
points in mind when you are searching for Off-Line Group
transactions:

• Make sure that the software has been set to Off-Line Group Mode
when you are searching for Off-Line Group transactions, or you
will not be able to find them.

 
• Once an Off-Line Group transaction has been transmitted to the

processing network, it is no longer an Off-Line Group transaction.
To find an Off-Line Group transaction once it has been
transmitted, search for it in Real Time Mode instead of Off-Line
Group Mode.

 
• Training Mode transactions entered in Off-Line Group Mode are

stored separately from “live” Off-Line Group transactions. Search
for these transactions by switching the software to both Off-Line
Group Mode and Training Mode.

Editing Transactions While Using Off-Line Group mode

Because Off-Line Group transactions are stored transactions that have
not yet been transmitted to the processing network, you have the
option of editing them while they are stored in the Off-Line Group
Input file. If you wish to do this, you must place the software in Off-
Line Group Mode, then use the Find feature to locate the transaction
you wish to edit.

1. While in Off-Line Group Mode, use Find to locate the transaction
that you wish to edit, then highlight it (you must be in Off-Line
Group Mode to find Off-Line Group transactions).
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2. Click the Edit button (Alt+E). The transaction will be displayed.
Some fields (for example, transaction type, card type) may be
disabled (meaning that they cannot be changed).

3. Change the transaction information as required.

You then have the following options:

• You can save the transaction (erasing the original transaction) by
selecting Save Transaction from the Edit pull-down menu.

• You can delete the transaction by selecting Delete Transaction
from the Edit pull-down menu. The display returns to the Find
Transaction box. Select Undelete Transaction if you need to
restore the transaction.

• You can select Stop Transaction Editing from the Edit pull-
down menu if you wish to cancel the edit and return to the
original transaction.
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Setting up ICVERIFY for Multiple Users

ICVERIFY can be set up for use by more than one computer, i.e., in a
“networked” environment. When configuring ICVERIFY for multiple
users, select one system on the network which will serve as a “master
station”. The master station handles all communications with the
processing network. It also handles all data file storage for the other
network stations running ICVERIFY. The master station and the other
network stations communicate by exchanging quote-comma delimited
ASCII text files (called “request” and “answer” files) using a shared
network directory. This directory can be at any location on the network
that is accessible to all of the network stations that will be processing
transactions. Because the master station processes transactions for all
of the other network stations, it must contain the modem that will be
used to submit transactions to the processing network.

Using standard computer network terminology, the master station
would be referred to as an ICVERIFY “server,” since it serves the
other computers that are connected to it. However, it is not a
requirement that the computer functioning as the ICVERIFY master
station be the same computer that acts as the network server.
Therefore, to avoid confusion, this manual uses the term “master
station” to refer to the computer that will be running ICVMLT32.EXE
and handling modem communications for the network stations. These
other stations on the network use ICVERIFY (ICVERIFY.EXE) for
transaction entry, and are generally referred to as “substations”.  If you
are using a point-of-sale system that has been designed to integrate
with ICVERIFY, you may use this point-of-sale system in place of
ICVERIFY on some or all of the network stations where transactions
will be processed.

A program called ICVMLT32.EXE is loaded at the master station.
This program processes transaction requests submitted by other
stations on the network. If you are using a point-of-sale system that
has been designed to integrate with ICVERIFY, you may use this
point-of-sale system in place of ICVERIFY on some or all of the
network stations where transactions will be processed.
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Setting up The Master Station
1. Choose the network station which will function as the master

station. This computer must contain the modem which the master
station will use to submit transactions to the processing network.

 
2. Install ICVERIFY on this computer. Run the setup program and

enter your processor setup information. Make sure that the
Evaluated Response field (located under the Merchant Info tab
in Advanced Setup) is set to Y.

 
3. Load ICVERIFY and try a test transaction to make that there you

are able to connect to the processing network without any
problems.

 
4. On the computer functioning as the master station, start the

program ICVERIFY Multi User from the ICVERIFY program
group (or run ICVMLT32.EXE from the copy of ICVERIFY that
has been installed on the computer housing the master station).
This will bring up the screen shown below:

5. Set the Request Directory field to contain the full path to a
shared directory accessible by all stations running ICVERIFY.
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This directory will be used by the other stations on the network to
submit transactions for the master station

6. Set the Process Files Every ... Seconds field to the number of
seconds you want ICVERIFY to wait between attempts to process
transaction requests. The default value is 3, which means that a
check for request files will be performed every three seconds. The
field accepts values from 1 to 99 (the default value of 3 should be
optimal for most situations).

 
7. In the Initialization String field, enter any initialization string

arguments you may require. These are command line parameters
which affect how the program loads. Under normal conditions it is
not necessary to enter anything into this field. See Appendix A for
a list of initialization strings.

8. Click the Initialize button. The GetLastError() Status field should
indicate successful completion of the initialization request.
Whenever you process transactions, the master station copy of
ICVERIFY must be running at all times.

9. Once the master station has loaded, it regularly checks the shared
directory specified in the Request Directory field for transaction
requests that need to be processed. Any transactions that are found
are processed and the corresponding answer files are placed in the
shared network directory to be retrieved by the substation or
integrated point-of-sale system that originated the transaction.

Note: ICVMLT32.EXE may be automatically loaded using the “/a”
command line argument. This eliminates the need to press the
Initialize button after loading the program. Once ICVMLT32.EXE has
been manually loaded at least once, the /a command will cause it to
load immediately, without requiring the user to press the Initialize
button and using the same settings that were used  the last time that
the program was loaded. The /a command should be used by creating
a Windows shortcut, then appending the /a to the command line to
used to load ICVMLT32.EXE. Do not use the /a command in the
Initialization String field. See Appendix A for more details.
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Setting up Substations
As mentioned earlier, all stations on the network which process
transactions do so by writing a transaction request file to the shared
directory which the master station is polling. Follow these steps to
configure each substation:

1. Install ICVERIFY on the network station which will be acting as
a substation (processing transactions). Do not run the setup
program after installing the software.

 
2. Find the directory where ICVERIFY has been installed on the

master station. Locate ICVERIFY.SET in this directory and then
copy this file to the ICVERIFY directory on the substation.

 
3. Load the copy of ICVERIFY installed on the substation. At this

point, this copy of ICVERIFY is not ready to process transactions.
It must still be placed in substation mode and then pointed to the
same shared directory which the master station was pointed to
when ICVMLT32.EXE was loaded.

 
4. From the Edit pull-down menu, select Options and then click on

the  Substation tab.
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5. Click on the Select Substation Mode checkbox, then select a
station number for this substation. The station number can be no
greater than the number of users that have been licensed for this
copy of ICVERIFY.  If you are not sure of the number of users
that you are licensed for, check the Number of Users field under
the Terminal ID tab of Advanced Setup.

 
6. In the Request File Path, enter the network path to the same

directory that ICVMLT32.EXE is pointed to. This directory will
be used for the exchange of transaction requests and responses.
You can also use the Browse… button to select the request and
answer file directory.

 
7. In the Master Station Drive field, enter the network drive letter

of the drive where the master station has been installed. The
substation will use this information to locate the data directory on
the master station.

 
 Note: If you can process transactions, but experience difficulty
 printing reports and finding transactions, double-check the
 Master Station Drive field to make sure that you have specified
 the correct drive letter.

 
8. Click on the OK button. When loading each substation, the first

transaction of the session can take longer than usual, since the
substation must gather information from the master station.  The
clerk will see the message “Waiting for response from master
station” flicker for about 30 seconds.  This is normal behavior.
Once a copy of ICVERIFY has been configured as a substation, it
should not be taken out of Substation Mode when processing
transactions.
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Setting Up ICVERIFY For Multiple Merchants

ICVERIFY can be configured to process transactions for more than
one business account, or more than one merchant account. Multi-
merchant processing may only be used after purchasing the
appropriate licensing from ICVERIFY. You will need to gather setup
information for each merchant as described in the Quick Start Guide,
get a validation code for each merchant's setup information and then
run the setup program to create a setup file for each merchant.
ICVERIFY switches between these setup files when processing
transactions for different merchant accounts. Configuring ICVERIFY
for multiple merchants is primarily a matter of creating a setup file for
each merchant, naming it correctly and making sure that each
merchant's transaction data is stored in a separate directory. There are
two very important concepts that must be understood if a multi-
merchant setup is to be implemented properly:

Naming Convention for Setup Files

Each merchant's setup information is stored in a file that ends with a
.SET extension. The default setup file in a normal, single-merchant
configuration is called ICVERIFY.SET.

In a multi-merchant setup, the standard naming convention for
ICVERIFY setup files is ICVExxxx.SET, where “xxxx” is a unique
merchant identifier which ICVERIFY uses to locate the correct setup
file when processing a transaction for a merchant.

Each merchant setup file created after setting up the first merchant
should have a four-digit merchant identifier as shown below:

Setup File NameData Directory Name Merchant Identifier
ICVERIFY.SET         DATADIR              RIFY
ICVE0001.SET         DATA0001              0001
ICVE0002.SET         DATA0002              0002
ICVE0003.SET         DATA0003              0003
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A Different Data Directory Must be specified for Each Merchant
During the Setup Process

Each merchant must have a separate data directory to store transaction
data. If this is not done, transaction data from different merchant
setups will be mixed together in the same files. The merchant's data
directory is specified by the Data Disk:\Directory field under the
Merchant Information tab of the Advanced Setup program. When
naming the data directories for each merchant, it is strongly
recommended that the directory name contain the merchant identifier
discussed previously (you can leave the data directory for
ICVERIFY.SET at its default value):

Setup File Data Directory Name Merchant Identifier
ICVERIFY.SET       DATADIR             RIFY
ICVE0001.SET       DATA0001             0001
ICVE0002.SET        DATA0002             0002
ICVE0003.SET       DATA0003             0003

Note: it is not necessary to use the numeric naming convention
outlined above (alpha characters could be used if necessary).
However, it is recommended that the numeric convention discussed
above be used as it aids in troubleshooting and file maintenance.
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Creating the Multi-Merchant Setup

Start by running the setup program and setting up the first merchant.
Complete the Setup Wizard and then select the option to run the
Advanced Setup program. Be sure to check the two setup options listed
below (Data Disk:\Directory and Settle All Merchants (Y/N), they
are both important when setting up the software for multiple
merchants:

Data Disk:\Directory
This field is located on the Merchant Information tab. It can be used to
define the name of the data directory where the software will store its
data files. You must specify a separate data directory for each
merchant in your multi-merchant setup. The name of the data
directory is usually tied into the merchant identifier as discussed
earlier. For the merchant using ICVERIFY.SET, this field can be left
at its default value of DATADIR, which indicates a DATADIR sub-
directory of the main ICVERIFY program directory. You will use the
numbering convention outlined earlier to set up the rest of your
merchants. Here's an example of how a setup for four merchants
should be configured:

Merchant Data Directory Setup File
Merchant 1 DATADIR ICVERIFY.SET
Merchant 2 DATA0001 ICVE0001.SET
Merchant 3 DATA0002 ICVE0002.SET
Merchant 4 DATA0003 ICVE0003.SET

This makes file maintenance and troubleshooting much easier,
especially in large multi-merchant setups.

Settle All Merchants? (Y/N)
If you would like to have the software settle all merchants at once
when a settlement for any single merchant is attempted this field must
be set to Y in each merchant's setup file. If you would rather manually
initiate settlement for each merchant individually, leave this field at its
default value of N.
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You will also want to copy down your Modem Port and Initialization
String field settings (located under the Hardware tab). Since all of
the merchants in your multi-merchant setup will use the same modem,
you will need to make sure that the Modem Port and Initialization
String fields are the same for each merchant's setup file.

Once you are sure that all of the Advanced Setup options are in order
for the merchant using  ICVERIFY.SET, save the setup and then exit.
Load ICVERIFY and then try a test transaction with the first merchant
setup to make sure that the modem is working correctly. It is
important to do this because each merchant setup must have the
correct modem settings in order to process transactions successfully. If
the modem appears to be working properly, take the following steps to
set up the second merchant:

Be sure to make a backup copy of ICVERIFY.SET before proceeding
any further.

1. Run the setup program again. This will load ICVERIFY.SET. Do
not make any changes to this file.

 
2. Select New from the File pull-down menu in Advanced Setup.

This will load the Setup Wizard and allow you to enter the setup
information for the new merchant. Complete the Setup Wizard
using the setup information for the new merchant, then load
Advanced Setup after the validation code has been entered.

 
3. Select the Merchant Information tab. find the Data

Disk:\Directory field and change the data directory name from
DATADIR to DATA0001.

 
4. Change the Settle All Merchants?(Y/N) field as described above

if you want the software to attempt to settle all merchants each
time that a settlement is attempted for any one merchant.

 
5. Select the Hardware tab. Use the information from the first

merchant setup to fill in the Modem Port and Modem
Initialization String fields.

 
6. Select Save from the File pull-down menu. Save the file as

ICVE0001.SET.
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7. Load ICVERIFY. Select Options from the Edit pull-down menu.
This will display the Modes tab.

8. Check the Multiple Merchants Mode checkbox, then click on
the Merchants Table button. This will pop up a box titled Select
Merchant. Click on the Add Merchant button.
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9. Enter the four character merchant identifier for your first 
merchant. Since this merchant is using ICVERIFY.SET, the 
merchant identifier for this merchant would be “RIFY”. Then 
click on the OK button. Only “RIFY” or numeric identifiers 
should be used when setting up merchants.

 

 
 

10. Click on the Add Merchant button again to add the merchant
using ICVE0001.SET. The merchant identifier for this merchant
would be “0001”.  The first two merchants (which use
ICVERIFY.SET and ICVE0001.SET) are now set up. You can
switch between these two merchant accounts by selecting Switch
Merchants from the Function pull-down menu.

Use the process outlined above to set up each additional merchant.
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Installments

Installments are used in situations where a customer is billed the same
amount on a recurring basis. For example, an internet provider that
charges customers a regular monthly fee could use ICVERIFY’s
installment billing feature to help automate the billing process. To
select installments, click on the Installments button (the button that
has a picture of a calendar on it) or select Installments from the
Function pull-down menu. You will then be presented with the two
tabbed selections that are used for handling installments:

Manage Installments
This tab can be used to add, edit or delete installment payments. To set
up a customer for billing, enter the customer's account information,
the number of installments that the customer will be billed and the
period between billings. You will also specify a start date which the
software will use to start calculating the billing of the customer. The
start date specifies the point at which the installment cycle for the
customer begins (the installment period specified must pass before the
customer is eligible for the first installment billing).

Transmit Installments
Customers will not actually be billed until the Transmit Installments
tab is used to submit installments to the processing network. When
installments are transmitted, ICVERIFY checks all of the installment
records that have been set up to determine which are due for billing,
then dials out to the processing network to approve these records. You
can transmit installments as many times a day as you need to (see note
below).

Important Note: Many processing networks have safeguards to
prevent the approval of duplicate transactions. This places some
limitations on installment billing, since submitting more than one
installment per day for any particular customer can result in a decline
from the processing network. If you fall behind on transmitting
installments for one or more customers, the software will transmit only
the first past due installment when installments are transmitted. Any
other past due installments will be eligible for transmission on
subsequent days (but only one installment per customer may be



37

transmitted on any given day). Setting up two separate installment
records for the same card number may also cause a rejection in some
cases.

Adding Installments
To add an installment payment, click on the Installments button (the
one that has a picture of a calendar on it) or select Installments from
the Function pull-down menu to open the Manage Installments tab.
Enter the customer’s credit card information. Then take the following
steps:

1. Use the Start Date field to enter the date that the software should
begin tracking the installment record. An installment payment
does not become eligible for billing on the start date. It will be
eligible for the first billing after the period of time specified in the
Installment Period field has passed. If you need to bill a customer
immediately, you will need to back-date the installment by the
period of time specified in the Installment Period field.

 
Example: a merchant sets up a customer for monthly installment
billing on March 15, and needs to bill the customer for the first
payment that day. To do this, the start date field must be set to
February 15. If the start date is set to March 15, the customer
would not be eligible for billing April 15.

 
2. Configure the total number of payments that the customer will be

billed for using the Number of Payments field. You may want to
continually bill the customer until you specify otherwise. If this is
the case, click on the Infinite Payments radio button.
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3. Select the period between installment billings by checking one of
the Installment Period radio buttons:

 
• Annually bills the same date the following year (April 28 to

April 28).
 
• Semi-Annually will bill 6 months later, same date (April 28

to October 28). If the date doesn't exist, then the next day will
be used as an alternate (for example, September 31 doesn’t
exist, so an installment due on this date would become
eligible for billing on October 1 instead).

 
• Quarterly will bill 3 months later, using the same date as the

initial billing date. If the date doesn't exist, then the next day
will be used as an alternate.

 
• Monthly: will bill one month later, using the same date as

the initial billing date. If the date doesn't exist, then the next
day will be used as an alternate (for example, February 30
doesn’t exist, so an installment due on this date would
become eligible for billing on March 1 instead).

• Semi Monthly bills on the first and fifteenth of each month.
 
• Weekly bills the customer on the same day as the start date

on the following week (e.g., every Tuesday).
 
• nnn days can be used to set the exact number of days between

each installment billing for the customer.
 
4. Click on the Add button to finish adding the new installment. It

will then show up in the transaction list box at the bottom of the
Manage Installments tab.
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Editing or Deleting Existing Installments

To change an installment, select the Manage Installments tab. Use
the transaction list box at the bottom of the tab to find the installment
and  double-click on it. This will fill in the Manage Installments tab
with the information for the installment payment so that it can be
edited. You then have the following options:

• Use the Reset button to clear the Add Installments tab of any
changes to the original record.

 
• Use the Save button to save any changes made to the installment

record.
 
• Use the Delete button to remove the installment record from the

current list of installments.
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Transmitting Installments

Use this tab to transmit installments. Pressing the Transmit button
causes ICVERIFY to begin a check all installment records that are due
for billing. Those that are due will be submitted to the processing
network in the form of a sale transaction (they will still need to be
settled after they have been approved). The other fields on this tab
provide information to help the user to determine what happened
during the transmission.

Number Sorted
This field shows the number of installment records that the software
has checked to see if they are eligible for billing.

Total to Sort
This field shows the total number of installments that will be evaluated
for eligibility in the current session.

Approved
This field shows the number of installments that have been approved
by the processing network during the current session.

Not Approved
This field is updated as installment transactions are being transmitted
to the processing network. It keeps a running total of the number of
installments that have not been approved during the current session.
This number also includes sorted records that are not eligible for
billing at the time of transmission.
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Current Transaction
This field displays the status of the transaction that is currently being
transmitted.

Transmit Transactions Progress
This field displays the overall progress of the current session.

Note: Once all of the installments have been transmitted, the Find
Transactions feature can be used to review the results after exiting to
the Credit Card Form.
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Importing Transactions

If you have a database or spreadsheet capable of exporting a batch of
transactions to a quote-comma delimited ASCII textfile, ICVERIFY
allows you to import and process this batch of transactions. Once
imported, these transactions are stored in an Off-Line Group Input
file for transmission to the processor at the operator's convenience.
Importing was possible with earlier versions of ICVERIFY, but
version 2.0 gives the user more control over how the information for
each transaction is formatted.

ICVERIFY requires that transaction data be presented in a rigidly
defined format in order to be successfully imported and processed.
The new import feature in version 2.0 functions an interpreter
between your application and ICVERIFY, allowing you to specify the
order in which the fields will be imported. The import feature
converts transactions into the format that ICVERIFY requires for
processing,  then stores them in the Off-Line Group Input file for
transmission at some later time (if your Off-Line Group Input file
already contains transactions, the imported transactions will be
appended to the transactions already in the file). Once this has been
done, the imported transactions can be submitted to the processing
network for approval by selecting Transmit Off-Line Group from
the Function pull-down menu.

Before explaining how the new import feature works, it is necessary
to explain a little about the format that ICVERIFY will be expecting
once the transactions have been imported. Here is an example of the
information required for a basic sale transaction with no address
verification information included.

"C1","ANNE","1429","431430196985032","9804","24.00"
   1   2     3   4                 5                  6

The text string shown above is generally referred to as a "Transaction
Record". A breakdown of each field for this particular record is
provided on the next page. A table of transaction record formats for
retail and mail order (and descriptions of the fields used when creating
them) are provided in appendices B and C.
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Field 1
This field contains a two-character command which tells ICVERIFY
what type of transaction it will be processing. This information is for
the program’s internal use only - it is not passed across to the
merchant’s processing network. The transaction currently being
discussed is a Sale (C1).

Field 2
This is the Clerk or "First Comment" field. It normally contains the
name of the Clerk entering the transaction. ICVERIFY does not pass
the information contained in this field to the processor - it is used for
internal record keeping purposes only. Some people do not use this
field, however, it cannot be left out when building a transaction record.
If the Clerk field is not selected for import, the Import Transactions
feature will insert a null Clerk field into the record created for the Off-
Line Group Input file so that it is accepted by ICVERIFY when the
Off-Line Group is submitted.

Field 3
This is the Comment or "Second Comment" field. It is often
transmitted to the processor, especially in the Restaurant, Mail Order
and Hotel credit card formats. It is usually used to store an invoice
number which can later be used to pull up a transaction using
ICVERIFY. The information contained in this field may show up on
the customer’s credit card statements. Some people do not use this
field, however, it cannot be left out when building a transaction record.
If the Comment field is not selected for import, the Import
Transactions feature will insert a null Comment field into the record
created for the Off-Line Group Input file so that it is accepted by
ICVERIFY.

Field 4
This field contains the customer’s credit card account number - no
spaces.

Field 5
This is the Expiration Date field. The expiration date should be
exported in MMYY format. If a slash is included between the month
and the year (e.g., “09/99” as opposed to “0999”), the slash will
automatically be removed as the transaction is imported.
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Note: ICVERIFY requires that the expiration date be presented in
YYMM format, but the Import Transactions feature will automatically
switch the format from MMYY to the YYMM when adding the
transactions to the Off-Line Group Input file. Applications using
request and answer files or directly creating an Off-Line Group Input
file without using the Import feature must pass the expiration date to
ICVERIFY in YYMM format.

Field 6
This is the amount field. It should contain a Dollar amount with the
decimal included.

The file created by your application may contain a virtually unlimited
number of transaction records, but each record must be separated by a
carriage return. Here is an example of a file containing two sales
transactions ("C1") and one book transaction ("C4").

“C1”,”KATE”,”1429”,”4017750003100019”,”9804”,”17.25
”
“C1”,”RON”,”1432”,”5499740000000040”,”9910”,”141.00
”
“C4”,”BOB”,”1437”,”372233154021042”,”9907”,”91.87”

An older version of ICVERIFY would require that you export
transactions from your database or spreadsheet using the exact format
that was just described, but the new import feature in 2.0 allows you
to specify the order in which ICVERIFY reads the data exported by
your application. For example, the following sale transaction:

“C1”,”BOB”,”1437”,”372233154021042”,”9907”,”91.87”

could be exported by your application as any of the following:

“372233154021042”,”BOB”,”1437”,”C1”,”91.87”,”9907”

“C1”,”BOB”,”1437”,”372233154021042”,”9907”,”91.87”

“C1”,”BOB”, ”91.87”,”372233154021042”,”9907”,”1437”

Each of the examples shown above contain the same information but
the order is different. The transaction could also be formatted in the
following manner:
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“Sale”,”BOB”,”1437”,”372233154021042”,”9907”,”91.87
”

Note that the “C1” transaction type code was replaced with the word
"Sale". ICVERIFY can automatically replace the word "Sale" with
the transaction type ("C1") as part of the import process. Please note
that if you use this method you will need to use the terminology that
is specific to your processing network for the transaction that you
want to process. Processor terminology for specific transactions can
vary. For example, a credit transaction can also be referred to as a
refund or a return transaction depending on the processing network
being used. If you would rather use the name of the transaction
instead of the two letter code that the software uses to identify it
internally, load the ICVERIFY graphical user interface and look at
the tabs that allow you to switch between transactions, then use the
terminology that is shown there.

Note: When exporting transaction data from your application, it is
important to make sure that the database of spreadsheet application
isn’t automatically formatting any of the fields (e.g., inserting a
dollar sign in the Amount field).

Let's assume that you use a database or spreadsheet application to
create a file containing one sale transaction, and that you will be
using the standard transaction record format for a sale as outlined
above. Here's the contents of the file:

“C1”,”BOB”,”1437”,”372233154021042”,”9907”,”91.87”

Here's the order of the fields for the transaction record shown above.
The order of the selected fields shown below (top-down) should
match the order of the exported data (left-to-right):

Transaction Type
Clerk
Comment
Account
Expiration Date
Amount
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Export the transaction data to a comma or quote-comma delimited
file in .txt or .csv format without column headings. Once the file has
been exported, take the following steps to import the transaction data
it contains into ICVERIFY:

1. Load ICVERIFY if it is not already running. Select Import
Transactions from the File pull-down menu. This will display the
box shown below. Highlight the first field for the format that you
will be using, then click on the Copy button to add it to the
Selected Fields list.
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2. Continue to add the fields that you need in the order that your
application will be exporting them. When you have finished, click
on the Save button to save the field configuration that you have
just set up. This will store the configuration in a filename of your
choosing (with a default extension of .imp) for future use. If you
need to, you can save multiple configurations which can be
accessed by clicking on the Load button.

 
Note: in order for a batch containing different types of
transactions to be successfully imported, you will need to add all
of the fields that are required by your processor for all of the
transactions that you will be importing.

 
3. Once you have defined the field order that ICVERIFY will use

when importing the transactions from the file that you have
created, click on the Import button to import your file. You will
then be presented with a box that will allow you to select the file
that you have created with your application:

 

 
4. Locate your file and double-click on it, or highlight it and then

click on the Open button. If the file is imported successfully, you
will get a dialog indicating how many records were successfully
imported. If the import was not successful, you will be returned to
the Import Transactions box, where the Errors field will provide
some information as to why the import failed.
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Selections for Import Transactions Dialog

Batch
This field displays the path to the Offline Group Input file that your
transactions will be imported to. This is the default path and filename
defined by the Offline Group Input File field under the Merchant Info
tab in Advanced Setup. The Browse button to the right of the field
allows you to import the transactions to a file other than the default
Offline Group Input file.

Available Fields
Lists all of the available fields which can be used to define a
transaction. Click on each field necessary for the transaction that you
will be doing in the order that you have exported the transaction
records, then click on the Add button. This will add the field to the
Selected Fields box (see Appendix B: Transaction Record Formats
for guidance as to which fields are required when creating transaction
records).

Selected Fields
Contains all of the fields that have been added from the Available
Fields box. This is the field order that will be used when the
transaction data is imported.

Copy
This button copies the field highlighted in the Available Fields box
to the Selected Fields box.

Copy All
This button copies all of the fields in the Available Fields box to the
Selected Fields box. If you plan on using most of the available fields
when importing your transactions, this button saves you the effort of
copying fields to the Selected Fields box one at a time. You can the
remove any extra fields by highlighting them and clicking on the
Delete button.

Delete
This button allows you to remove fields displayed in the Selected
Fields box.
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Up and Down buttons
These buttons are used to change the position of a field displayed in
the Selected Fields box. This allows you to make adjustments in the
field order without clearing the Selected Fields box and starting from
scratch. To change the position of a field in the list, highlight the field,
then use the up or down buttons  to move it to the desired position.

Column Order List
The Save button allows you to save the field configuration that is
currently displayed in the Selected Fields box. You will be able to
specify the name of a configuration file containing the order and type
of fields that were selected. This file will have a .imp extension. Once
you have stored a field configuration, you can select that configuration
by using the Load button.

The Load button allows you to load a previously saved field
configuration. You will be presented with a dialog that will allow you
to select the configuration that you wish to use. Once you have selected
the file that contains the configuration that you want, the fields for that
configuration will be displayed in the correct order in the Selected
Fields list.

Format
This drop-down menu is used to specify the type of file that will be
imported. Files with a .txt or a .csv extension can be selected for
import.

Errors
If the import failed for some reason, the Errors box will contain
information that indicates why the operation failed. The first line of
the error message contains the first record of the import that failed and
the second line describes the nature of the error.

Note: All records in error are written to a file called ERRORS.TXT.
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Exporting Transactions

This feature can be used to export transaction data to a spreadsheet or
database application. You can export the data as ASCII text or
Microsoft Access files. The source of the data exported depends on the
mode that is currently selected. If you are processing transactions real-
time, all transactions that are currently in the open batch will be
exported. If you are currently running in Off-Line Group Mode, all of
the transactions stored in the Off-Line Group Output file will be
exported.

The processor's response can be exported by including Response in the
Selected Fields box for export. You may only export a response for
credit card transactions, not debit or check guarantee.

Example of a Response From an Approved Transaction

“Y12345612345678”

The Y at the beginning of the field indicates that the transaction was
approved. This is followed by a six-digit approval code (in italics) and
an optional reference number.

Example of a Response From a Declined Transaction

“NPICK UP CARD”

The N at the beginning of the field indicates that the transaction was
declined. The text of the response from the processor follows.

If you have configured ICVERIFY for address verification (AVS), the
software will return a one character response that indicates how valid
the address information is:

“Y12345612345678Y”

The Y at the end of the field indicates that the address and five-digit
ZIP code provided matched with the account information. See
Appendix D for a list of possible AVS result codes.
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Here are the steps that you will need to take to export transaction data
to a file:

1. Select Export Transactions from the File pull-down menu. This
will display the window shown below. Use the radio buttons near
the top of the window to select the type of data to be exported:

2. Highlight the first field for the format that you will be using, then
click on the Copy button to add it to the Selected Fields list.
Continue to add the fields in the order that you wish them to be
exported.
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3. You can export data as ASCII text or Microsoft Access (.mdb)
files. If you are exporting the data as ASCII text, use the Text File
Attributes section to specify how the file will formatted for
export. If the Include Field Names check box is checked, the first
line of the exported text file will be a list of the field titles in the
order that they were exported.

 
4. When you have finished, click on the Save button to save the field

configuration that you have just created. This will store the
configuration in a filename of your choosing (with a default
extension of .exp) for future use. If you need to, you can save
multiple configurations which can be accessed by clicking on the
Load button.

 
5. Once you have specified the structure of the file that you will be

exporting, click on the OK button. You will then be prompted to
enter a name for the file:

5. Enter a file name, then click on the Save button to export the file.
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Selections for Export Transactions Dialog

Radio Buttons (Credit, Debit and Check Guarantee)
Use these radio buttons to select the type of data you will be exporting.

Available Fields
This box lists all of the available fields which can used when exporting
transaction data. Click on each field that should be included in the
order that you want exported, then click on the Add button. This will
add the field to the Selected Fields box on the right.

Selected Fields
Contains all of the fields that have been added from the Available
Fields box. This is the field order that will be used when the
transaction data is imported.

Column Order List
The Save button allows you to save the field configuration that is
currently displayed in the Selected Fields box. You will be able to
specify the name of a configuration file containing the order and type
of fields that were selected. This file will have a .exp extension. Once
you have stored a field configuration, you can recall it for use by
selecting the Load button. Once you have loaded the file that contains
the configuration that you want, the fields for that configuration will
be displayed in the correct order in the Selected Fields list.

Format
This drop-down menu is used to specify the type of file that will be
exported. Transaction data can be exported as ASCII text or Microsoft
Access files.

Text File Attributes
These options are used when exporting data as ASCII text. You can
specify the field separation character, the start/end character for each
field and whether or not field names will be exported (the first line of
the file is a list of field titles in export order).

Note: If you wish to export transactions in tab-delimited format, enter
a “t” into the Field Separation Character field.
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Generating Reports (The Report Menu)

How to View or Print Transaction Reports

The report menu allows you to create a variety of simple or detailed
reports summarizing transaction activity. These are the kinds of
reports that you may create: Credit Card Report, Debit Card
Report, Check Guarantee Report, Settlement Report and Off-Line
Group Reports.  Each report is described in this section.

Credit Card Report
This report allows you to view or print a summary of credit card
activity for a specified date range or to match select data (customer,
clerk, account or card type). Use it to track credit activity for a defined
period. Note that this report will show only credit card activity.

Starting Date and Ending Date
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Use these fields to set the date range for your report. If the current date
is used as both the starting date and ending date, the report will show
current transactions that have not yet settled/closed. If a report
showing the current day’s settled/closed transactions is required, enter
today’s date as the starting and tomorrow’s date as the ending date.

Month-to-Date totals are printed if the date range includes only one
month, starting with the first day of the month. Year-to-date totals are
printed if the date range includes only one month, starting from the
first day of the month, and that month is the current one.

Include Details or Totals Only
One one of these options may be selected at a time. Include Details
will generate a detailed summary report. Totals Only will generate a
summary report only.

Sub Totals
Displays settlement totals at each closing.

Report Options
Use these check boxes to narrow the search criteria for your reports.
The boxes to the left are all credit card types. If you wish to do a
search for one credit card type only, be very careful to make sure that
the Captured checkbox has been left UNCHECKED. If this isn't done,
the report will reflect all transactions for the selected card type plus all
CAPTURED transactions (approved transactions which can be settled)
for ALL card types. The checkboxes in the right column are described
below:

• Captured
 This option will list all transactions that have been approved and
 can be settled. This option does not include transactions such as
 book or pre-authorization/auth only transactions, which cannot be
 settled until they have been completed by a ship (in the case of a
 book transaction) or a force/ticket only (in the case of a pre-
 authorization/auth only transaction). If you want to search for one
 specific card only, make sure that the Captured box has been
 unchecked or you will get a report for the card that you have
 selected plus all other transactions that qualify as captured.
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• Not Captured
This option will list all transactions that cannot be settled directly,
such as book or pre-authorization /auth only transactions (see
Captured above).

 
• Missing Tips

Lists all transactions that are missing tips.
 
• Errors

This option will list all transactions that have been declined.
 
• Other

 Lists inquiries.
 
• Serial # Seq

Lists all transactions regardless of status.
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Debit Card Report

Use this report to view or print out a summary of debit card activity

Starting Date and Ending Date
Use these fields to set the date range for your report. If the current date
is used as both the starting date and ending date, the report will show
current transactions that have not yet settled/closed. If a report
showing the current day’s settled/closed transactions is required, enter
today’s date as the starting and tomorrow’s date as the ending date.

Month-to-Date totals are printed if the date range includes only one
month, starting with the first day of the month. Year-to-date totals are
printed if the date range includes only one month, starting from the
first day of the month, and that month is the current one.

Include Details or Totals Only
One of these options may be selected at a time. Include Details will
generate a detailed summary report. Totals Only will generate a
summary report only.
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Sub Totals
Displays settlement totals at each closing.

Report Options
Use these check boxes to narrow the search criteria for your reports.

• Captured
This option will list all transactions that have been approved and
can be settled.

 
• Not Captured

This option will list all transactions that cannot be settled directly,
such as Book or Pre-Authorization /Auth Only transactions (see
Captured above).

 
• Missing Tips

Lists all transactions that are missing tips.
 
• Errors

This option will list all transactions that have been declined.
 
• Other

 Lists inquiries.
 
• Serial # Seq

Lists all transactions regardless of status.
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Check Guarantee Report
Use this report to view or print out a summary of check guarantee
activity

Starting Date and Ending Date
Use these fields to set the date range for your report. Month-to-Date
totals are printed if the date range includes only one month, starting
with the first day of the month. Year-to-date totals are printed if the
date range includes only one month, starting from the first day of the
month, and that month is the current one.

Include Details or Totals Only
One of these options may be selected at a time. Include Details will
generate a detailed summary report. Totals Only will generate a
summary report only.

Sub Totals
Displays settlement totals at each closing.
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Settlement Report

The settlement report can be used to view or print a report of the last
settlement/close batch procedure that was performed. It can be used to
produce a hard copy of the settlement for filing. Use the radio buttons
to select whether you wish to view or print the report (there are no
other options for Settlement reports):

Note: Some merchants use host-based processing networks that auto-
settle transactions. This type of processing network settles the
merchant’s captured transactions at its end, usually on a daily basis,
without requiring the merchant to perform a Settlement/End Day
procedure. For this type of processing network, ICVERIFY must
internally “settle” captured transactions, transferring them from the
open batch to the history files so that it stays in synch with the
processing network. This means that a settlement report printed by a
merchant using this type of processing network will show a settlement
report containing the previous day’s transactions only.
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Off-Line Group Reports

There are a number of reports that are designed specifically to keep
track of Off-Line Group activity. To access them, select Off-Line
Group from the Report pull-down menu. For each type of report
selected, you will be presented with the option to view or print the
report as shown below (there are no other options for Off-Line Group
reports):

Here are the available reports:

Group
This prints a report of the transactions in the current Off-Line Group
(Use this report when you wish to view the group that is about to be
transmitted).

Result
This prints the results of the last transmitted Off-Line Group.

Duplicate
This report shows transactions in the current Off-Line Group that have
matching card numbers.

History Duplicate
Prints the transactions in the Off-Line Group File that have card
numbers which match History transactions.
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File Menu Options

Import Transactions
Allows the user to import a batch of credit card transactions created by
another application (see page 42 for more details).

Export Transactions
Allows the user to export credit card, debit card and check guarantee
transaction data for use by another application such as a database or
spreadsheet (see page 50 for more details).

Print Receipt
Allows the user to print a receipt for any transaction that is currently
being viewed.

Printer Setup
This selection is used to define the report and/or receipt printer that
will be used by ICVERIFY.

Save Installments
Allows the user to save a new installment or an existing installment
that is currently being edited.

Exit
Closes ICVERIFY.
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Edit Menu Options

Undo, Cut, Copy and Paste
These are all typical Windows functions that can be used while editing
transactions.

Find Current Transaction
Used to locate and edit current transactions (approved transactions that
have not been settled or Off-Line Group transactions that have not
been submitted to the processing network). The Find Current
Transaction feature has been integrated with transaction types where
finding transactions comes into play. (see page 20 for more details).

Save Transaction
Used to save a transaction that is currently being edited.

Delete Transaction
Used to delete a transaction that is currently being edited.

Stop Transaction Editing
Stops transaction editing without saving any changes to the
transaction that is currently being edited.

Options
Brings up a tabbed dialog box that presents various options for
configuring ICVERIFY (see next page).
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Options Dialog

Clerks tab
This tab allows you to store and maintain the list of clerk names that
can accessed from the Clerk pull-down menu while processing
transactions.

Clicking on the Add or Remove buttons will allow you to add or
remove clerks from the pull-down list . To select a clerk, click once on
the clerk's name to highlight it and then click on the OK button.
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Modes tab

Debug Mode Check Box
Debug mode is used to troubleshoot software problems. When
operating in debug mode, the software will log information that is
useful to programmers. This information is written to a file called
ICVERIFY.DBG, which is stored in the directory where the program
files have been installed. This file can be opened using any text editor,
however, the information contained in the file is in a highly technical
format. Each time that the program is started in debug mode any pre-
existing debug file is renamed to ICVERIFY.DBO.

Multiple Merchants Mode Check Box
This box must be checked to enable Multiple Merchants Mode. To
add, remove or select merchants, click on the Merchants Table button
to the right of the check box.

Merchants Table Button
Used to add, delete or switch merchants in a multi-merchant setup.
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Training Mode Check Box
This selection causes ICVERIFY to simulate a response from the
processing network for training purposes. No dial-out will occur when
transactions are submitted. Any transactions authorized or settled
while in Training Mode are stored separately from live transactions.

Note: Training Mode transactions are always approved if done for an
even amount. Transactions done for an odd amount are rejected
unless they end with 5 cents (i.e., $12.95 or $1.05 would be approved).
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Receipts tab
Use this tab to enter a receipt message and to set the number of
receipts that will be printed whenever a transaction is approved. The
receipt message can be up to 30 characters in length.

To set up a receipt printer, select the Printer Setup Option from the
File pull-down menu.
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Serial Device tab
This tab is used to specify the COM port and device type for serial
devices. Supported devices are Verifone 101 compatible pinpads,
Verifone 201 compatible pinpads with card swipe and a generic serial
card swipe setting.

Device Port
Used to enter the port setting the serial device will be using.

Device Type
Enter the type of serial device here. Pinpad devices must be Verifone
101 or Verifone 201 compatible.



69

Substation tab

This selection is used to configure a copy of ICVERIFY to run in
Substation Mode in a multi-user setup (see page 25 for more details
about configuring ICVERIFY for multiple users).

Select Substation Mode
This box must be checked before the other fields become active.

Substation #
This selection is used to assign a unique station number to this
substation. The station number cannot exceed the number of users
licensed to use the software. Up to 999 substations can be supported
with the appropriate licensing. A single-user license will allow only
one substation. A basic multi-user or network license allows 4 users,
so you would be able to configure substations with station numbers
ranging from 1 through 4. If you are unsure of the number of users you
are licensed for, load the Advanced Setup program and check the
Number of Users field (located near the bottom of the Terminal ID
tab).



70

Master Station Drive
This is the drive where the master station has been installed to.

Request File Path
This field is used to enter a path to the shared directory that will be
used to exchange request and answer files. This path must point to the
same directory which was entered into the Request Directory field
when setting up ICVMLT32.EXE.

Time/Date tab
This selection is used to configure the time and date format for the
Clock Pane, which is located in the lower left hand corner of the
Graphical User Interface:

The selections on the time and date tab do not affect the format of the
time and date display in the Status Box (shown below):
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View Menu Options

Toolbar
This menu option is used to show or hide the Toolbar, which is the
row of buttons located underneath the pull-down menu selections:

If the Toolbar pull-down menu option is checked in the Edit menu,
then this row of buttons will be displayed (this is the default). If
Toolbar is not checked, the row of buttons will be hidden.

Note: All Toolbar items are also available through the pull-down
menus. If a button is disabled, this means that the function that the
button represents is not set up or is currently unavailable). For
example, the button which allows you to reprint a receipt (second from
right) will be inactive until a transaction has been processed.

Status Bar
This setting allows you to choose whether or not the status bar will be
displayed. The status bar is the bar running along the very bottom of
the user interface:

The status bar displays some information about the item the user has
currently selected, and also contains the Clock Pane (the date/time
display at the right end of the status bar).

Credit Card Form
Used to switch to the Credit Card Form.

Debit Card Form
Used to switch to the Debit Card Form.

Check Guarantee Form
Used to switch to the Check Guarantee Form.
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Function Menu Options

Convert Book To Ship
Finds and converts approved book transactions to ship transactions.

Settlement/End Day
This selection is used to perform the settlement/end of day process, or
to preview the batch before settlement.

Switch Merchants
Use this selection to switch merchants when ICVERIFY is in Multiple
Merchants Mode (see page 30 for more details).

Off-Line Group Mode
Toggles Off-Line group Mode off and on. Off-Line Group transactions
are stored in an Off-Line Group Input file for batch transmission to the
processing network (see page 22 for more information).

Transmit Off-Line Group
Used to transmit all transactions stored in the default Off-Line Group
Input file. A non-default file may also be selected (see page 22 for
more information).

Installments
Loads the Installment (recurring billing) selections (see page 36).
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Report Menu Options

Credit Card
Allows the user to print a report of credit card activity (see page 54 for
more details).

Debit Card
Allows the user to print a report of debit card activity (see page 57 for
more details).

Check Guarantee
Allows the user to view or print a report of check guarantee activity
(see page 59 for more details).

Settlement
Used to view or print a report of the last settled batch (see page 60 for
more details).

Off-Line Group
This selection provides access to several Off-Line Group report options
(see page 61).
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Utilities Menu Options

File Print
This is a simple file printing utility that is usually used to print debug
files. When file print is selected, the path to the debug file is already
specified. It is possible to enter an alternate path and filename by
either manually entering the information or by using the browse
option.

Ymodem File Send
This test is often used by merchants setting up for American Express.
It is used to transmit a specified file to a specified phone number using
the Ymodem format.

Substation Test
The substation test is used after the software has been configured to act
as a substation in a multi-user setup. A test sequence is sent to the
master station to make sure that it is responding correctly. If a
substation test fails, the first thing to do is to make sure that the
substation and the master station are both pointed to the directory
which will be used for the exchange of transaction requests and
responses.

Delete Partial Off-Line Group
This function is used when an Off-Line Group transmission has failed.
It deletes the tracking file that is used to keep the position in the Off-
Line Group file.

Reset Batch
This feature allows the user to reset the number of the current batch.
Under normal conditions, this feature is not used. It is recommended
that you do not reset the current batch number unless you have been
instructed to do so by a technician.

Clear Batch
This feature is used to clear the open batch file without performing a
settlement/close batch procedure. When clear batch is selected, the
software will transfer the transaction data from the open batch to the
history files without dialing out. Do not use this function unless you
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are certain that your current open batch has already been settled by
your processing network.

Delete Current Batch
This function clears the current batch of all transactions. It is normally
used only during testing with test account setup information.

Find Settled Transaction
This feature is used to find settled transactions stored in ICVERIFY’s
history files. It is most commonly used when a merchant wishes to
print a receipt for a settled transaction. Please note that settled
transactions cannot be located using the Find Current Transaction
menu selection (accessed from the Edit pull-down menu) because it
only searches for unsettled transactions stored in the current open
batch or Off-Line Group Input file.

Password Protection
This dialog box allows for the password protection of various menu
selections. It is also possible to create a password for the entire
application. If you use this feature, it is strongly suggested that you
keep copies of your password(s) in a safe place to help ensure that you
do not get locked out of a password-protected feature or the program
itself.

Password For:
This drop-down list allows you to select a pull-down menu or
transaction form for password protection. This selection affects the
items presented in the Select Menu Item/Select Transaction pull-
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down menu described below. Use the Entire Application selection to
create a password that will be requested whenever ICVERIFY is
loaded.

Select Menu Item/Select Transaction
This is the drop-down menu below the Select Menu / Form drop-
down menu (the title varies depending on whether a menu or a form is
selected for password protection). The selections associated with this
item are dependent on the form or menu selected.

Select Password
Allows the entry of a new password for the selected transaction type or
menu item.

Change Password
This can be used to change an existing password.

Remove Password
This can be used to remove password protection for the selected item.
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Help Menu Options

Help
This selection loads the online help file, which can also be accessed by
pressing F1.

Tip of the Day
This selection displays the Tip of the Day window, which is normally
displayed when the program is first loaded.

Tooltips
This enables or disables the flyby help that appears when a cursor is
placed over an object.

Context-Sensitive Help
Determines whether the context-sensitive help tab is active or inactive.
If this item is not checked, the Help tab will not be updated when it is
selected.

About ICVERIFY
Displays information about the version of ICVERIFY that is currently
being used and the product serial number.
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Appendix A: Initialization Strings

There are a number of command line parameters that can be used with
ICVMLT32.EXE. These commands (with the exception of /A) are
entered into the Initialization String field when loading the program.
The /P command discussed below can be used with both
ICVMLT32.EXE and ICVERIFY.EXE.

/A (Auto Initializes ICVMLT32.EXE)
Once ICVMLT32.EXE has been initialized at least once, the /A
argument will cause ICVMLT32.EXE to automatically initialize using
the same settings that were used the last time that the program was
initialized manually. This switch should not be used in the
Initialization String field. Instead, create a shortcut to run
ICVMLT32.EXE, then append the /A to the command line in this
fashion:

C:\ICVWIN\ICVMLT32.EXE /A

The example above assumes that ICVERIFY was installed to
C:\ICVWIN.

/DD (Places ICVMLT32.EXE In Training Mode)
The /DD command line parameter can be used in the Initialization
String field to place ICVMLT32.EXE into Training Mode. When the
/DD command is used, ICVMLT32.EXE will treat all transactions it
receives as Training Mode transactions and process them
accordingly. This command line parameter is generally used only
when testing an integration between ICVERIFY and another
application. If you wish to place the GUI into Training Mode, choose
Options from the Edit pull-down menu and then check the Training
Mode check box (this will only affect the substation where Training
Mode was selected).
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/P (Loads a Setup File other than ICVERIFY.SET)
This command line parameter can be used to load a setup file other
than the default. This is sometimes useful in testing and multi-
merchant setups. The syntax for this command line parameter is /P
[Set File Name] where [Set File Name] is the name of the set file to
be loaded. To load ICVMLT32.EXE using ICVE0005.SET enter the
following into the Initialization String field:

/P ICVE0005.SET

The /P switch can be used with ICVERIFY.EXE by creating a shortcut
and appending the switch and set file name to the command line in the
same manner as shown above.

Note: When specifying the setup file name, the .SET extension must be
specified or the setup file will not be loaded.

/O[x] (Evaluated Response)
This command line parameter forces the program to use the short,
evaluated response when returning the response from the processing
network. This response type is required from ICVMLT32.EXE by the
substations in order for a multi-user setup to function properly.  The
response type can also be configured in the setup file by using the
Evaluate Rsp (Y/N/B/L/D/S) field under the Merchant Information
tab in Advanced Setup. The optional ‘x’ causes ICVMLT32.EXE to
return the original request on the first line and the short, evaluated
response to the request on the second.

/XX (Debug Mode)
The /XX parameter can be used to force ICVMLT32.EXE into debug
mode. All program activity will be logged to a file called
ICVERIFY.DBG, which will be located in the directory where the
program files have been installed. This file is often used for software
troubleshooting, however, the information it contains is in a highly
technical format.
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Appendix B: Transaction Record Formats

These transaction records provided as a guide for use when importing
transaction data from another application. The formats shown below
are correct for most credit card networks and options. There are a
small number of special options not included. The most common
names are used in this table. The first column is a literal transaction
type indicator (C1,C2, ST, etc.). The remaining columns are defined
in appendix C.

Retail Charge Card Authorization Formats

Sale
C1 CMc CMM ACT EXP AMT ZIP ADD
Void
C2 CMc CMM ACT EXP AMT APV
Credit/Return
C3 CMc CMM ACT EXP AMT
Credit Void
CR CMc CMM ACT EXP AMT APV
Force
C5 CMc CMM ACT EXP AMT APV ZIP ADD
Auth Only
C6 CMc CMM ACT EXP AMT ZIP ADD

The ZIP & ADD are optional and for record keeping purposes in a Force Sale).

Mail Order Charge Card Authorization Formats

Book
C4 CMc CMM ACT EXP AMT ZIP ADD
Ship
CO CMc CMM ACT EXP AMT ZIP ADD
Sale
C1 CMc CMM ACT EXP AMT ZIP ADD
Void Sale
C2 CMc CMM ACT EXP AMT APV
Credit/Return
C3 CMc CMM ACT EXP AMT
Credit Void
CR CMc CMM ACT EXP AMT APV
Force Sale
C5 CMc CMM ACT EXP AMT APV ZIP ADD
Auth Only
C6 CMc CMM ACT EXP AMT ZIP ADD

(ZIP & ADD are optional and for record keeping purposes in a forced sale)
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Appendix C: Field Descriptions
Field
ID

Min
Len

Max
Len

Field
Type

Field
 Description

ABA  9  9   0 ABA Number
ACT  6 19   0 Credit Card Account number
ADD  0 20   1 Address (Optional field)
AMN  0 13   5 Amount of Additional Cash (Cash-back)
AMT  0 13   5 Amount of Purchase
AMt  0 13   5 Total Amount
APV  2  6   1 Approval Code
CKN  2  6   0 Check Number
CHo  3 16   0 Account Number
CH2  2 25   0 Account Number
CMA 10 10   2 Check-in Date (format: MM/DD/YYYY)
CMc  0 32   1 1st Field (Clerk)
CMD 10 10   2 Departure Date (format: MM/DD/YYYY)
CMe  2  2   1 State Code
CME  0  7   5 Additional Charges
CMI  0  6   0 Invoice/folio number
CMM  0 32   1 2nd Field (Comment)
CMN  0 20   1 Customer Name
CmP  1  1   3 Preferred Cardholder (Y/N)?
Cmr  0 13   5 Room Rate
CMS  0 20   1 Server ID
CMT  0 20   1 Ticket ID
DOB 10 10   2 Date of Birth
DLn  4 30   1 Driver’s License Number
EDT 10 10   2 Ending Date (format: MM/DD/YYYY)
EXP  3  4   0 Expiration date (YYMM only. May also hold

card swipe)
HRD  1  1   3 Printer? (Y/N)
MID  0  4   1 Merchant ID
MTD  0 30   1 Message of the Day
NUL  0  0   - Null field (just “”)
PIN 16 16   1 Encrypted PIN number as returned from the PIN

PAD
REF  7  8   0 Reference Number
RPS  0 10   4 Report Options
SDT 10 10   2 Starting Date (format: MM/DD/YYYY)
STE  2  2   1 State Code
SUM  1  1   3 Summary? (Y/N/S/D)
SWP  0 38   1 Swiped card information (track 2 only)
TAG  1  1   3 Print receipts? (Y/N)
TIP  0 13   5 Amount of tip
ZIP  5  9   1 ZIP Code (optional field)

Field Types
0 = Numeric   3 = “Y” or “N”
1 = Alphanumeric   4 = Report Type
2 = Date (MM/DD/YY)   5 = Currency
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Appendix D: Address Verification Result Codes
This list of result codes is provided for use when exporting transaction
data to a database or spreadsheet.

LETTER/CODE DESCRIPTION

A (ADDRESS) Address matches, ZIP does not match

E (EDIT ERROR) (For example, address verification not 
not allowed for this transaction)

N (NO) Both address and ZIP do not match

R (RETRY) System unavailable or timeout

U (UNAVAILABLE) Address information is unavailable

W (WHOLE ZIP) Nine-digit ZIP matches, address does
not match

X (EXACT) Address and nine-digit ZIP both match

Y (YES) Address and five-digit ZIP match

Z (ZIP) Five-digit ZIP matches, address does
not match

The information in this appendix was taken from National Data
Corporation’s Electronic Data Capture Technical Specifications,
Release March 1991, Copyright 1987-1991 by National Data
Corporation.
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